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General Information

About the TimeBox program
This program is designed for use by contractors, and other workers who need to track the
time they spend working. The program presumes that there might be any number of jobs
or clients (referred to by the program as projects) that the user will need to track. The
program also allows projects to be cross-referenced with tasks, or types of work
performed. The program also presumes that the user will be "off the clock"; that is, not
performing trackable work 24/7.

Features
To help you track your time, the TimeBox application features a "punch-clock" approach.
Simply punch a button and identify what project and task you are about to begin. The
application also allows you to attach notes to your work. This way you can, for example,
leave reminders of specifically what work you've performed on a given day.

Recognizing that you might not always be in front of the same computer when you
start/stop/switch work activities, the TimeBox application also features a mini-web server.
As long as your main computer (the one on which your instance of TimeBox is installed)
has a dedicated Internet connection, you can punch in and out from another Internet-
enabled computer or PDA. You can also perform other simple actions remotely, such as
viewing weekly summaries of your recorded time. The Web server requires you to create a
username and password for remote access; it uses basic authentication to ensure that no
unwanted users can access your instance of the TimeBox application. And of course, you
can control whether or not the server is running.

In addition to allowing you to view quick summaries, the TimeBox application allows you
to generate reports of projects and tasks that you've tracked in the past. You can print,
view, or save these reports to disk. You can also import your reports into a spreadsheet or
database application for further number-crunching.

The application also allows you to edit time that you've already tracked, to easily add past
days that you forgot or were unable to track. You can also create archives of your tracked
time, as well as backups to protect your data. The application also allows you to search
through previously recorded time across a variety of criteria.

TimeBox is also an integral part of the TimeSuite time management system. The other
major component of this system is the ClokBox™ application. ClokBox is a server-based
application designed to help entire workgroups track their collective time. TimeBox users
can automatically submit their recorded time to a central ClokBox application. The
ClokBox administrator can then track the time of all workers on a particular project or
series of projects, generate reports based on all users’ time or the time tracked by select
users, etc. ClokBox runs on multiple platforms, such as Mac OSX, Windows, and Linux,
and is sold as a separate application. Information can be found at
http://www.taubler.com/clokbox



The ability to track tasks was added in versions 5 of both TimeBox and ClokBox. For that
reason, version 5 or higher of both TimeBox and ClokBox should be used together.

Of course, the TimeBox application can be used entirely on its own, if you plan to track
only your own projects and tasks.

This diagram demonstrates the interaction between TimeBox and ClokBox. Various TimeBox instances (A)
submit their time to a single ClokBox server (B). This ClokBox server can then run various reports (C)
containing all users’ data at any time.



Registration and Support

TimeBox is considered "shareware", which means that you are allowed to use the
application for evaluation purposes. If you find that application to be useful, then you are
expected to register to continue using it.  Registration is handled on a per-user basis. That
means that you can download and use one or more copies of TimeBox yourself. For
example, you might want to use a Windows version on your PC and a separate OSX
version on your Macintosh. As long as you are the user for both copies, one registration
fee will cover both copies. However, if your home or organization has more than one
TimeBox user who use their own TimeBox copies, a registration fee must be paid for each
copy.

Registration entails paying a nominal fee to receive a registration code. Once you receive a
registration code, simply access the Help > Register... menu. Enter your name in the first
box, and the provided code in the second box, and click OK.

Unregistered versions of the TimeBox application will periodically nag users to register. In
addition to removing these nags, registration will also entitle the user to email support.
Registration information can be found at http://www.taubler.com/timebox

Instructions and FAQs can be found at http://www.taubler.com/timebox  In addition,
registered users can access email support there.

How to Use the TimeBox Application

General use
The TimeBox tool allows you to track time for multiple jobs or clients.  This means that,
for example, if you are doing part-time work for Company ABC, and part-time work for
Company XYZ, you can use the TimeBox tool to separately track hours spent working for
each company. The TimeBox tool refers to a client or job as a project. TimeBox creates
your first project, called Off-clock, for you. This project has special meaning; it signifies
that TimeBox should not be tracking time. You would use this project type to indicate, for
example, that you are out for lunch or gone home for the day--essentially, that you are not
currently working.

With the TimeBox application, you can also track time according to tasks. A task is a
particular type of work that can be performed; examples might include programming,
design work, meetings, or administrative tasks. Your projects, then, will typically share
the same pool of tasks. While the concept of projects (formally called activity types)
existed in previous versions of the TimeBox application, the concept of tasks is new
starting with TimeBox version 5. For this reason--and because some users of TimeBox will
find tracking tasks to be irrelevant, a "default" task, called Not specified, has been pre-
created. If you decide to track only by projects, and not by tasks, simply use the Not
specified task when tracking your time. You can also use this task if you happen to be
performing work that does not have a relevant task. For example, anytime you indicate



that you are "Off-clock", TimeBox automatically assigns the task of "Not specified" to that
time period.

Projects, then, generally describe for who you are performing work, whereas tasks
generally describe actually what you are doing. With TimeBox, you can cross-reference
between both.

Let's take the hypothetical example of a firm that designs web sites. This firm would likely
have a list of tasks that includes administrative tasks (such as scheduling, invoicing, etc.),
meetings (which could even be further broken into client meetings, project meetings, and
administrative meetings), concepting, graphic design, and programming. This firm
might also have a number of projects at one time; for example XYZ Corp Intranet, Bob's
Bakery Website, and Toys 4 Pets Online Store. A designer working for our hypothetical
firm, then, might track part of her time as spent in a meeting (the task) for Bob's Bakery
Website (the project).

The TimeBox user can now run reports to determine, for example, how much time she
spent working on Bob's Bakery Website during a given time period. Or she can report on
the amount time she spent performing graphic design. Perhaps most usefully, she can also
report on the total time spent, during a specific period, performing graphic design work for
Bob's Bakery Website.

Launching the application
The Windows installer should have created a shortcut or alias in your computer's main
menu. Use this shortcut or alias to launch the TimeBox application. Alternatively, you can
open up the folder that the installed created; in there, you will find an executable called
TimeBox or TimeBox.exe. You can launch the application by double clicking on this icon.
However, you are encouraged to create a shortcut or alias of this executable and move it to
your desktop, or to some other location away from the TimeBox folder.

Macintosh users will find a TimeBox folder on their disk after downloading the
application. The application is contained within this folder. Simply drag the application to
the desired location, such as to your computer’s Applications folder. Launch TimeBox by
double clicking. You may also want to create a shortcut for the application; e.g. by
dragging the application to your dock.

Users familiar with Java who want to create their own startup scripts can do so by
including the JAR file (tt.jar) in the classpath and invoking
com.taubler.timebox.TimeTracker  A JRE version 1.2 or higher is required; 1.3 or higher is
recommended.



Adding New Projects and Tasks

After launching the TimeBox program, your first job should be to enter your initial
projects. You should also decide if you want to track time by tasks as well and, if so, enter
your initial tasks in the same window. You will probably want to track by tasks if, for
example, it is important for you to know not only how much time you spend working on
certain projects, but how much time in each of those projects is spent in meetings, how
much is spent doing research, how much is spent doing design or programming, etc.

Adding a new project and/or task can be done in the Projects and Tasks dialog. To access
this dialog, go to the Time menu and select Projects and Tasks.... You will see a dialog that
is split into two halves; the left half handles your projects, and the right half handles your
tasks. If this is the first time you have accessed this dialog, you will notice the pre-created
Off-clock project and Not specified task.

Select Time -> Projects and Tasks… to bring up the projects and tasks management screen. Then, you can
click on the new project…button to add a new project, or new task… to add a new task.

To add a new project, just click the new project button. A dialog will appear, asking you for
the name of the new project.  Enter a name; this will be the name that the TimeBox
application uses to refer to your new project. Optionally enter a description of the activity.
Click OK. Adding a new task is done in the same manner except, of course, that you click
the new task button.



After clicking the new project button, enter a name and, optionally, description of your new activity

You cannot change the name that you give to an activity. However, you can assign a
nickname to the activity. In doing so, you are telling the TimeBox application to refer to
the activity by the nickname. To do this, click the edit... link next to the activity to which
you would like to apply a nickname. A small window appears. In the field provided, enter a
nickname and, optionally, a description. To accept, click OK; to cancel, click Cancel.

Click the red “edit…” link next to  project or task, and a small window will appear. This window will allow you
to edit the description of the project or task, and give it a nickname



You may decide that you will temporarily not need to track a certain project or task. You
un-activate a project or task in the Projects and Tasks window simply by un-checking the
box next to the name of the project or task that you want to make inactive. De-activating a
project or task will reduce unnecessary clutter in other windows throughout the TimeBox
application, while allowing you to later re-activate the project/task (which is done by re-
clicking the checkbox).

You are also allowed to permanently delete a project or task. Of course, you should be
certain that you will never need to track such a project or task again before deleting. Once
you delete a project, any past times tracked under that project will be reported by TimeBox
as "Off-clock". Similarly, once you delete a task, any past times under that task will be
reported by TimeBox as "Not specified". To delete a project or task, click the delete button
located to the right of the project or task in the Projects and Tasks dialog, and then click
Yes in the resulting popup.

Because the Off-clock project indicates to TimeBox that you are finished performing
trackable work, you can never remove, nor inactivate, this activity. However, you can give
this project a nickname, as described above. The same stands for the task Not specified,
which is also provided by the application.



Tracking Time

Once you've set up the projects (and tasks, if relevant) that you will be performing, you can
begin tracking your time. This is done through the main application window. This window
is divided into three parts: a panel displaying today's activities, a panel displaying totals of
the times tracked today, and two buttons. Simply click the switch activity button, and you
will receive a window with one panel listing all of your projects, and another panel listing
your tasks. Just click the radio button next to the name of the project that you are about to
perform. If you wish to track a specific task, click the button next to that task name;
otherwise, leave the button next to Not specified selected. You’ll also notice pulldown
menus that allow you to specify a specific time; they default to the current time, so you can
typically leave them alone.

If later you need to work on another activity, and thus start tracking time for it, just do the
same thing: click the switch activity button and select the new project (and task, if
relevant). The application automatically stops tracking time for the first activity, and
begins tracking for the second.



Click the Switch Activity button to display the Switch Activity window. Select a project and task (or leave the
task at its default position, Not Specified) and click OK. In the above example, the TimeBox user is indicating
that she is about do begin design work for Client ABC. Notice that the Switch Activity window provides you
with both a New Project… and New Task… button as shortcuts to creating new projects and tasks. Notice
also that you can select a specific time for your new activity to take place.

If you are tracking tasks, and you switch from one project to another but are performing
the same task (for example, you are doing design work for Project ABC, but are about to
begin doing design work for Project XYZ), you still need to re-select the task. When you
are done working altogether, click the switch activity button and select Off-clock (or
whatever nickname you might have assigned to off-clock). The task will automatically be
set as Not specified.

The activities will be captured in the top activity panel. If you need to edit any of them (for
example, to change the time, project, or task), just click on the arrow symbol to the left of



the activity and choose edit from the resulting popup. Edit the activity using the provided
pulldown menus, then click the arrow again and choose Save.

The Switch Activity window also allows you to insert activities from earlier in the day. For
example, say you got into work at 9:00 and began working on a project for Client
ABC—but didn’t begin tracking time. Then a few hours later, you began tracking time for a
new project. If you later realize that you forgot to track your time spent on Client ABC, you
can simply launch the Switch Activity window, select your project and task, then set the
activity’s time to 9:00 AM using the provided pulldown menus. Your activity will be added
to the appropriate time slot.

You can also track—at a glance—the total time during the current day for that project, as
well as all other projects, in the bottom Total Times panel. You can also choose a custom
date from which to track times. Click the Custom label in the Total Times panel and enter
the date. For example, if you want to watch the amount of time spent on each project
during the past week, you can enter the date of the previous Sunday or Monday; the total
times tracked for each project since that day will be displayed.

Note that the switch activity window also provides you with a shortcut to add a new
project or task, if the one you have not already created the appropriate one. Just use the
new project… or new task… button provided in the window.

An alternative way to switch activities is to simply drag the label of the desired project
from the bottom (Time Totals) panel to the top panel. You will notice that the task will
default to Not specified. If you wish to indicate a specific task, simply click the arrow to the
left of the activity you just recorded in the top panel, select Edit, and then use the provided
pulldown menu to select the appropriate task. (You can also edit the time or the project
here, if necessary.) Click the arrow again and select Save when you are done.



One way to switch activities is to drag a label from the bottom frame to the top frame. In the above example,
the TimeBox user is indicating that she is going off-clock.

The program also lets you attach notes in two places: 1. You can attach time-specific notes
to a particular activity describing, for example, precisely what work you performed at a
specific time during the day; 2. You can attach general daily notes to an entire day
describing, for example, what work you performed throughout the day.

To enter a time-specific note, click on the arrow symbol to the left of the appropriate
activity in the top activities panel. In the resulting pulldown menu, select Note…  You will
be presented with a popup dialog in which you can add new notes for that specific activity,
or edit any notes that you may have already entered for that activity. Click OK when done.



Click the arrow symbol to the left of an activity, and select Note… to attach a note to that activity.

To enter a daily note, simply click the Add Notes button. A dialog will appear, allowing you
to enter or modify the notes for that day. Click OK when done.



For example, for a consultant who is employed by ABC consultancy, and is performing
work for XYZ client, a typical day might look like this:

1. Get into work. Click Switch Activity and select the XYZ project  and Design task.
2. Go into an ABC staff meeting. Click switch activity and select the ABC task button

and the Meeting task button.
3. Go back to working on the project. Click switch activity and again select the XYZ

and Design task.
4. Go to lunch. Click switch activity and select the Off-clock radio button. The task will

default to Not specified.
5. Come back from lunch and perform some administrative work for ABC.

Click switch activity and select the ABC project button and the Administrative Work
task button.

6. Go into a meeting hosted by XYZ. Click switch activity and select the XYZ and
Meeting task.

7. Go home for the day. Drag the Off-clock radio button to the activities panel. Click
add notes and enter a brief description of the project worked on, and the meetings
attended.

When the consultant needs to review time that has been previously worked, s/he can do so
with the View Summaries window (see the “Viewing Daily and Weekly Summaries”
section for more details.) Similarly, if the consultant needs to modify time that has already
been tracked, or needs to add an entirely new day that s/he was unable to track in the
manner described above, s/he can do so with the Edit Days window (see the “How to Edit
Tracked Time” section for more details.)

Sharing projects and tasks
Some users might need to track time on different instances of TimeBox on different
computers. For example, a user might typically track his or her time on a desktop
computer, but occasionally work remotely on a laptop. In order to help ensure consistency
between multiple instances, TimeBox has the ability to export and import projects and
tasks.

To export the projects that you currently have entered in a TimeBox instance, simply go to
the Time -> Import/Export -> Export Projects menu. In the resulting dialog box, navigate
to the directory that you want to save the export file to, enter a filename, and click Save. To
export tasks, do the same, except use the Time -> Import/Export -> Export Tasks menu.
Once you've exported the projects or tasks from one instance of TimeBox, you should copy
that file to the computer running another instance of TimeBox. From that instance of
TimeBox, go the Time -> Import/Export Types -> Import Projects (or Import Tasks)
menu. From the resulting dialog box, navigate to the copied file, and click Open. Note that
TimeBox will attempt to detect if you are accidentally trying to import a tasks file into your
projects list, or vice-versa. The application will warn you if it makes such a detection.



Automatically retrieving projects and tasks from ClokBox

If you are using your instance of TimeBox with a group, which is in turn collectively
reporting time with the ClokBox application, then you can retrieve any projects and tasks
that have been created by the ClokBox administrator. Instructions can be found in the
Submitting Times to the ClokBox Server section. You can also automatically submit any
project/task names that you've created within TimeBox to the ClokBox server; those
instructions are also found in the Submitting Times to the ClokBox Server section.

Time Zones and Daylight Savings Time
Different computers are set up to handle time zones and Daylight Savings Time in
different ways. In most cases, TimeBox can interprete how the computer on which it is
running handles these issues. In certain situations, however, TimeBox may report the
wrong time; for example, your computer's clock indicates that the time is 10:00AM, but
TimeBox logs time at that moment as 11:00AM. TimeBox might also tell you that times are
out of order when you try to add or edit times, when in fact they are in proper order.

If you notice that the time reporting by TimeBox is different than the time shown on your
computer's clock, you can quickly rectify this issue by going to the Preferences frame
(Time -> Preferences..., or on Mac OSX, TimeBox -> Preferences.) In the Daylight Savings
Time area, select the Tell TimeBox to adjust time by checkbox. Then, indicate with the
pulldown menus whether TimeBox should add or subtract time, and by how much. If the
time reported by TimeBox is later than that reported by your computer's clock, you should
tell TimeBox to subtract time; if TimeBox's time is earlier than your computer's, tell
TimeBox to add time. For example, if your computer's clock indicates that the time is
10:00AM, but TimeBox logs time at that moment as 11:00AM, select the checkbox, then
choose Subtracting and 1 hour from the pulldown menus.



Viewing Daily and Weekly Summaries

You can view your past time tracked in two ways: 1. generate a custom report, as described
later in this document, or 2. quickly view weekly and daily summaries, as described here.

To quickly view weekly or daily summaries, select the View menu, then choose Weekly
Summaries.... The window that appears will be split into two parts. The top part will list all
of the weeks for which you have logged time. The weeks are identified by their Mondays.

The top window lists the available weeks (indicated by the date of the Monday contained in that week; for
example, the highlighted week above is labeled according to the fact that Monday, October 06, 2003 is part
of that week,) The bottom lists the daily summaries for the selected week. By default, summaries for projects
cross-referenced by tasks will be shown. If you need to view summaries only for projects or for tasks, use
the pulldown menu at the bottom, as demonstrated in the screenshots below.



View only projects by selecting Projects from the pulldown menu.



View only tasks by selecting Tasks from the pulldown menu.



When a day is selected, clicking the button on the bottom-right will pop up a window that displays all of the
notes recorded for that day; double-clicking the row will do the same.  Summaries of times recorded, along
with any time-specific notes and general notes, will be shown.



To view the daily summaries for a particular week, highlight the week in which you are
interested. The table below will be populated with the individual days of that week. Each
row consists of a single day. When you first launch the window, each column represents a
project cross referenced by a task, plus two additional columns:

The first column will display the name of the day.
The last column will contain the notes for that day.

So if you are currently tracking two projects and have three tasks that you can perform,
you will have eight columns: 2 projects x 3 tasks = 6, plus the name-of-day and notes-for-
day columns equals 8. Recognizing that this might be too much detail, the TimeBox
application allows you to view time breakdown by only project, or by only task. Use the
pulldown menu at the bottom, which should read Projects and Tasks, to specify just
Projects or Tasks.

You can also view the details for any of the days currently showing. To do this, highlight
the table cell that contains the notes that you want to view, and click the show details…
button. Or, simply double-click on the table cell that contains the desired notes. A small
popup window will appear, displaying any recorded times for the day, along with any notes
recorded.

Note: no dates will appear in the top frame, and no data in the bottom frame, if you have
not already logged time.



How to Edit Tracked Time

Editing an existing day
Select the View menu, then choose Past Days. You will be presented with a split-screen
window that consists of a view of a filesystem on the left, and an editing screen on the
right. If you do not see a split-screen, that means the window did not open on its own;
simply drag the window-divider from the left-hand side of the window toward the middle
of the window.

When the window first opens, the filesystem view will list the base location of your data
files. Double-click it to expand it. It will open to reveal all of the weeks for which you have
logged time. The weeks are identified by the date of the Mondays that they contain.
Double-clicking on a week will in turn open that week to reveal all of the days in that week
for which you have logged time.

The Day Editor window is divided into two panes; on the left is the “filesystem view”, which organizes
recorded times into weekly folders that contain individual days. For example, in the left-hand window above,
the week containing Monday, Feb 10, 2003, is expanded, showing three individual days from that week. On
the right is a pane that—when an individual day is selected from the filesystem view—displays details
recorded about that specific day. The image above shows the day that was selected (Feb 11, 2003) in the
left-hand frame loaded into the right-hand frame.



To edit a specific day, highlight that day and click the OPEN button above, or just double-
click on that day. The data for that day will be loaded. To edit a time that was already
recorded, just use the pull-down menus provided. Hour, minute, AM/PM and activity type
can be edited. In addition, you can click on the arrow to the left of any activity to delete it,
or revert to its saved state. Furthermore, you can move the activity back or forward, if it is
not listed in the proper order. Activity-specific notes can be entered or edited in the
textfield located below the activity’s pulldown menus. Notes for the day can also be edited
in the Notes frame. Once you are satisfied with the changes, save them by clicking the Save
button. Note that all times must be in proper order before the changes can be saved.

What happens if you need to add a new activity? Simply click the New Activity button, and
a new activity, ready for you to edit as described above, will appear. The activity will
appear at the end of the list of activities. If that activity must appear earlier than any other
existing activities, simply click the arrow at the left of the activity. A pulldown menu will
appear, allowing you to select Move Back. This will move the activity above (before) the
previous activity. Clicking Move Forward will move the activity below (after) the following
activity.

Once you begin editing a day, you are not allowed to edit any other days until you are
finished.

Adding a new day
You might need to add data for a new day if, for example, you forgot or were unable to log
your time for a certain day. To do this, right-click or (for Macintosh users) control-click in
the filesystem view screen, and select New day... . Or click the New Day button, which
looks like a page from a daily calendar, at the bottom left corner of the window. A dialog
will appear, asking you to enter a date. Once you have entered a valid date, the program
will create the day and you will be able to open, edit, and save it as described above.



Add a new day by right-clicking (or control-clicking on the Macintosh) in the left-hand pane, and selecting
“New day…”  A window like the one depicted above will appear. Create a new day by entering the year, then
the month, then the day.

Archiving past weeks
Once you've been using TimeBox program for awhile, you may find it difficult to weed your
way through all of the weeks that you've tracked in the past. That's why the TimeBox
program allows you to archive weeks that you've tracked in the past, and that you don't
think you'll need to view on a regular basis. You archive weeks in the Day Editor window.
Simply select the week that you would like to archive, and right-click or (for Macintosh
users) control-click and select Archive week. A dialog will appear asking for confirmation;
be sure that the week shown is the week that you want to archive, and click Yes.



Select a week and right-click (or control-click on the Macintosh) and select “Archive week”.  Click “Yes” on
the resultant dialog box.

An alternative method is to simply select the desired week to be archived and click the
archive button at the bottom of the screen, or just drag the desired week to the archive
button.

If you later decide that you need to unarchive, or re-activate a week that you had
previously archived, you can do this via the Archives window. Select the View menu, then
choose Archives... . A filesystem tree will appear. Expand the tree in the same manner as
described above for the Edit Days window. Select the week that you want to unarchive,
and right-click or (for Macintosh users) control-click and select Unarchive week. Or, you
can select the week and click the unarchive button at the bottom of the frame, or just drag
the week onto the unarchive button (which looks like a calendar square.)  Weeks can be
deleted permanently from this frame as well, by using the delete button (which looks like a
trash can.)



Archived weeks wind up in the Archive window. To delete an archived week, either drag it to the trash, as
shown above, or select it and then click the trashcan icon.

Searching through past days
You can use the Day Entity window to search through past days, and find days that match
a particular criterion. To start, click on the Search button at the top right-hand corner. A
search window appears, allowing you to set various criteria. First, enter any word or
phrase the must match in the days’ Notes section. Leave this field blank if you do not wish
to search based on Notes content.  In the Activity Types scroll panel, ensure that the



names of the projects that must be included in the search results are selected. Finally, in
the Date Range box, select dates between which the matched days must be. For example,
in the frame depicted below, the user is searching for days whose notes contain the word
“Test” (case-insensitive), contain the activity types Contact, Freelance, and/or Testing (or
any other activity type), and were recorded for the weeks between Nov 15 2001 and Feb 18
2002 (inclusive).

Click the Find button in the Day Entity window to pull up the Seach window. Clicking the Search button
above will find all days whose notes contain the word “architecture” (or “Architecture”, or “ARCHITECTURE”,
or “ARCHitecture”…), contain at least Client ABC, Project XYZ, and/or XYZ Intranet as projects and contain
both Coding and Meeting as tasks, and were recorded for the weeks between Jan 12 2004 and Jun 14 2004
(inclusive).

Search results will appear in a separate window. Any of the days that appear in the results
window can be examined by clicking the row desired. Doing so will cause the selected day
to be loaded in Day Entity window. Note that the selected day will not be loaded if there is
already a day being edited.



Remote Access

This program contains a Web server that allows you to track your time remotely. In order
to use this service, however, the computer on which this program is installed must have a
dedicated Internet connection. Having a static IP address (check with your Internet
Service Provider (ISP) if you don't know what this means) is helpful but not absolutely
required. Also, some equipment provided by ISPs contain firewalls which might block
access (again, check with your ISP regarding this.)

Configuring the server
Provided your Internet access meets this criteria, you can configure your server using the
Remote > Server... dialog. In this window, you should enter a username and password.
For security reasons, you are required to create a username and password to use the
remote access feature. You can also change the server's port number in this window. This
feature will primarily be used by advanced users. Suffice it to say that if you don't know
what a port number refers to, you can safely leave it as its default value. However, if you
receive an error when you try to start the server, indicating that the port is already in use,
you can change the port number to another arbitrary number (most computers require
that you keep it above 1000.) (see Appendix A, What is a port number?, for more details.)
Finally, in this window, you can use the provided checkbox to indicate whether the server
should start automatically every time you launch the TimeBox application.

You must establish a name and password before you can start the server.  You can specify a new port
number for your server to run on, and by selecting the checkbox, you can ensure that the server will start
any time the TimeBox application is launched.

To start or stop the server by hand, select Remote > Server On. The application must be
running and the server on, for you to track your time remotely.



Select Start Server from the Remote menu to turn TimeBox’s Web server on or off.

Log files
The server also provides three log files:

Messages: shows informative messages about the state of the server.
Warnings: warns the user about activities that might cause problems.
Errors: informs the user about server errors that have occurred.

To view these files simply select Remote > Server Log, then select from the three server
log options provided. A log window will appear. To the average user, these log windows
may not display much of interest, but those familiar with Web server activity may find
them helpful.



Accessing the application remotely
To remotely access this application, you will need the following at your remote location:

1. A computer or device with an Internet connection. This computer should have a Web
browser on that device (currently, the application's server generates HTML content,
which will display in standard Web browsers such as Mozilla, Netscape, Opera or
Internet Explorer, as well as some browsers on Palm Pilots and other PDAs.) This
browser should support basic authentication (basic password-protection).

2. Knowledge of the username and password that you set up for your server.
3. Knowledge of your computer's IP address (this is a numeric address that will identify

your computer to all other computers on the Internet.)
4. Knowledge of the port number that the TimeBox application is using.

You can determine the last two pieces of information by viewing the server information.
Just open the Remote > Server Info window. When the server is running, this window will
display the IP address that your computer is using, and the port number that the
application is using. These two pieces of information comprise the URL, or web address,
that you will use to access this application remotely, as such:

http://IPADDRESS:PORT/
For instance, if your IP address is listed as 253.253.253.253 and your port number is set to
371, you would type the following address into the remote browser:

http://253.253.253.253:371/

The Server Info window will provide the information you need to access your TimeBox server from a remote
computer. In the above example, the user could point any standard Web browser to
http://253.253.253.253:371/ to use the TimeBox instance remotely.

When you access the application through a browser in this manner, the browser will first
prompt you for a username and password. Just enter the username and password that you
established, typed exactly the same way. Once you do this, you are presented with a Web
page that will allow you to perform these functions:

1. Switch Activities: Click on the Switch Activities link, select from the available
projects and tasks, and/or enter notes, and click the Switch Activity/Commit
Notes button.



2. Enable/Disable Activities: Click the Adjust Settings link, and select/deselect
the activities that you want to activate/inactivate (the same way you would in the
application's Settings window) and click commit activate/inactivate.

3. View Weekly Summaries: click on the View Summaries link. Select a week
from the list provided, and click the view week button. After a brief pause, the
Web page will display the summaries for that week.

You can access your TimeBox application remotely through a standard Web browser.

The Web page will always display the accumulated activities for the current day on the left-
hand side of the window.



Generating Reports
The TimeBox application allows you create custom reports about your time tracked. You
can view, save, or print these reports, as well as import them into third-party spreadsheet
or database applications.

Creating a report
To create a report, select the File menu, then choose Report Generator.... The Report
Generator window will appear. It is in this window that you set the parameters for how
your report will be created.

You can create a report in one of three formats: Tab Delimited, XML, or Formatted For
Viewing. Tab Delimited will format a report suitable for, say, importing into a spreadsheet
program (most spreadsheet and database programs will accept data in tab-delimited
format.) Formatting For Viewing is designed to allow you to quickly view and/or print a
report without the use of external programs. XML might be useful for programmers who
want to write a program to process the report; it might also become useful with later
versions of the TimeBox application. You must choose one of these three formats for your
report using the radio buttons provided.

The Report Generator window will allow you to customize your reports.



You can also decide whether to include notes in your report. You do this by using the
Notes checkbox. Selecting this checkbox ensures that any notes you entered will be
included in your report. Leaving the box unselected will result in a report that presents
only time summaries.

In the row labeled Report On:, indicate whether you want to generate numbers for
projects, or tasks, or whether you want to cross-reference between both.

In the panel labeled Include these activities in report, you are presented with a list of
checkboxes that correspond to every activity that is currently active. Ensure that the
checkboxes next to the activities that you want included in your report are selected, and
that those next to the activities you want omitted from the report are deselected. Similarly,
in the panel labeled Tasks to include, ensure that the checkboxes next to the tasks that you
want included in your report are selected, and that those next to the tasks you want
omitted from the report are deselected. Note that if you selected Projects or Tasks above,
the opposing set of checkboxes will become inactive.

You may only want your report to cover a specific time period. You can set this parameter
in the Date Range panel. This panel contains two pull-down menus; each contains all of
the weeks (named by the Monday they contain) for which you have any time tracked. Use
the first menu to select that "from" date; that is, the earliest week that you want included
in the report. Use the second menu to select the "to" date, or that latest week that you want
included in the report.

If you would like your report to have a title, enter that title in the text area provided.

Outputting the report
You can either view the report immediately, save the report, or print the report to a
printer. Use the buttons at the bottom of the Report Generator window to indicate which
you would like to do.

1. Selecting View Report will launch a mini-window that will present your report to you.
That window gives you two control buttons at the top: a button that toggles word-wrap,
and a button that allows you to set the relative size of the text for that window.

2. Selecting Print Report will bring up a standard print dialog box, and will allow you to
print the report to any printer that you have connected to your computer.

3. Selecting Save Report will launch a dialog box in which you can name your new file, and
determine where on your computer to save it to.

4. Selecting Close will close the Report Generator window.

Note: you can only create a report if you have already logged time. This may seem obvious,
but you cannot generate a report based on no time tracked. The report output options
described above will not be active unless you have time logged.



Backups

Purpose of backups
The TimeBox application allows you to create backups of your data. There are two primary
reasons you might want to do this. The first, most obvious reason, is to protect your data
against loss. Making regular backups of your data, and storing these backups in a location
that is different than the disk from which you are running your TimeBox instance, will
ensure that if some minor disaster happens (your disk becomes corrupted, an electrical
storm fries your computer, etc) you can still restore your data later.

The second reason to create a backup is to move your data from one TimeBox instance to
another. For example, if you start using TimeBox at home, but later decide that work is the
best place to use it, you can create a backup of your data at home, transport it to your work
computer via disk or the Internet, and import it to the instance of TimeBox running at
work.  Similarly, if you begin using TimeBox on a PC but then switch to a Macintosh, you
can install the Macintosh version of TimeBox, backup your data from your PC, and import
it into your Mac's instance of TimeBox.

Creating backups
To create a backup, simply go to the File > Backup > Create Backup…  menu.  In the
dialog presented, click the Select Directory: button to choose the directory to store your
backup file. In the text field below, enter the name you choose for your backup file. Note
that the backup files are stored in ZIP compression format; if you choose to append a file
extension to your filename, .zip is appropriate but certainly not required.

If you choose to include your archived data in the backup file, then be sure the Include
archive data in backup checkbox is selected.  Click OK, and your backup file will be
created. If you did not specify that your backup file be created on a disk separate from the
one on which your TimeBox application is stored, you might consider copying it to a
floppy, ZIP, CD-ROM, or separate hard drive.  This will ensure that you have a copy of
your data in case your main hard drive is compromised.

Importing backups
If you somehow lose all of your existing data, or if you are moving data from one instance
of TimeBox to another, then it is time to import your pre-existing backup. Open the File
menu and select Backup > Import Backup....  A file dialog will appear, asking you to select
the backup file that should be imported.  Navigate to the file and click Select.

Although TimeBox expects that you will not have any pre-existing data (since, in most
cases, you will be restoring lost data or you will be populating a new instance of TimeBox
with data), it will make every effort to not overwrite any existing data that it encounters. If
there is a chance that existing data will be overwritten, TimeBox will asks you how to
handle the situation. Two conditions can occur:

1. All of the data from the backup file conflicts with existing data. In this case, you can
choose to either let the existing data remain intact (in effect, canceling the import) or to



cause the import to overwrite the existing data.  In a dialog box, TimeBox will explain
that the latter option (in which the existing data will be overwritten) is about to occur.
Click Yes to allow that to occur, or No to cancel.

2. Some of the data from the backup file conflicts with existing data. In this case, you can
choose one of three options: 1: cancel the entire operation; 2: restore only as much data
from the backup as possible without overwriting any existing data; 3: restore the backup
and overwrite any existing data that conflicts.  Simply choose from the menu provided
the options that matches your choice, and click OK.



Submitting Times to the ClokBox Server

Many TimeBox users will be tracking time only for their own projects, and are not
concerned about jointly tracking time as a part of a group. These users will probably not
find the features described in the following section very useful.

For those who are working as a part of a group, TimeBox allows the ability for users to
submit their time to a central server. The server administrator can then run reports on the
collective times submitted by all users. Note that your instance of TimeBox must be
registered before you are able to submit time to a ClokBox server.

The server application is called ClokBox. Detailed information, as well as the application
itself, can be obtained from http://www.taubler.com/clokbox

For ClokBox to be able to communicate with the ClokBox server, at least some of the
activity types must match. There are three ways to ensure that this happens:
1. You can simply type in your activity types exactly as they appear in the ClokBox server

application, including spellng and capitalization.
2. Your ClokBox administrator can export the ClokBox activity type settings and send

them to you (details can be found in the ClokBox user guide and help window.) You can
then import your settings into your instance of TimeBox. Simply save the export file
anywhere on your hard drive. Then go to TimeBox’s Time menu and select Import
Types…. Navigate to the export file and click Choose.

3. If you’ve already been tracking activities and you discover that their names don’t match
the names entered in ClokBox, you can create a mapping. That way your activity type
names will essentially be changed to match the types entered in ClokBox as they are
submitted. Details on how to do this are later in this section.

Settings
Before setting up your ClokBox instance for time submission, you will need the following
information from your ClokBox administrator:

• The URL or IP address of the ClokBox server
• The port number under which the ClokBox server is running
• Your username
• Your password



The “Address” and “Port” numbers from the ClokBox window should be entered into the respective fields in
the TimeBox Time Submission window.

The first two can easily be ascertained by the ClokBox administrator; the last two will have
been entered by the ClokBox administrator in ClokBox's Users panel.
Your time submission settings are all maintained within the Time Submission Settings
window. You can access it via the Remote menu, selecting the Time Submission submenu,
then the Settings menu item. The Time Submission Settings window will appear. You will
notice a few different sections, detailed below:

ClokBox Server Info
At the top of the frame, enter in the spaces provided the four items you should have
received from your ClokBox administrator: the ClokBox address and port number, and
your username and password. The ClokBox address tells your instance of TimeBox what
Web server to submit your time to; the port number provides further instructions to the
Web server. Your username and password are required to ensure that only you are
submitting time under your name.

Submit Time How?
The next section is the Submit Time How? section. You have three options as to how to
submit your time to ClokBox.
1. Automatically

The first option is to have TimeBox automatically submit your time for you on either a
daily, weekly, or monthly basis. If you select this radio button, the pulldown menus to
the right will become active. In the first pulldown menu, select whether you want
TimeBox to submit your time on a daily, weekly, or monthly basis.
• If you select Daily, you'll notice one set of pulldown menus appearing below. This

set of pulldowns asks you to select what time of each day TimeBox should submit
your time.

• If you select Weekly, you'll notice two sets of pulldown menus appearing below. The
first allows you to set what day of the week to submit time. The second set of



pulldowns asks you to select what time of the selected day TimeBox should submit
your time.

• If you select Monthly, you'll notice two sets of pulldown menus appearing below.
The first allows you to set what day of the month to submit time. For example,
selecting "On day 12" will cause TimeBox to submit time to ClokBox on the 12th of
every month. The second set of pulldowns asks you to select what time of the
selected day TimeBox should submit your time.
Note that for automatic time submission to work, TimeBox must be running during
the selected time.

2. Manually
The second option is to submit time yourself whenever you want to. To do this, select
the Manually radio button. The Submit Time Now button to the right will become
enabled (assuming you've already filled out the top section.) Click it to submit your
time; TimeBox will submit your time to the address and port umber you'd entered
above. Additionally, a small button will become active on the bottom-right side of the
main TimeBox window. Clicking this button will similarly submit your time to
ClokBox.

3. Output to File
In case you do not have a reliable internet connection, or you find yourself plagued
with firewall problems, you can still submit your time to ClokBox. In this case, select
the Output to File radio to button. The Output to File now... button will become
activated. When you click it, a file dialog will appear. Your times will be exported to the
file you select in the dialog. You will then need to send this file to the ClokBox
administrator, either via disk, email, or another electronic means. Note that, as
described above in the Manually section, choosing the Output to File option will cause
a small button to become active on the bottom-right side of the main TimeBox window.
You can use this button to output your times to file as well.

Details
In the bottom section, you can enter your Details settings. The first checkbox, Only submit
times not yet sent, determines whether TimeBox should only submit time that it has not
already sent to ClokBox. The second checkbox, Only send times between the following
weeks, determines whether ClokBox should only submit time that falls within a certain
time period. Use the pulldown menus provided to then indicate the first week and last
week in that time period.

The Use project name mapping option can be selected under special circumstances. If a
TimeBox user has already begun tracking time, s/he may later discover that his/her
project names do not exactly match the project names entered in ClokBox. In such a case,
the ClokBox server will reject that data. To solve this problem, the TimeBox user can map
his/her project names to diffferent project names, that match the names entered in
ClokBox, as they are being submitted. Select the check box, and then click the Show/edit
mappings... button. A Data Mapping window will appear, displaying each project entered
in this ClokBox instance, and a corresponding text field. Enter the new, "correct" project
name in the text field next to any incorrect name. Click Save when done. Note that doing
this only affects names of projects submitted to the ClokBox server.



The User task name mapping option works the same way except, of course, it modifies the
names of tasks that are submitted. Use this option in the same manner as described above
for projects.

The Specify activities to send option can be selected to control what activity types are sent
to the ClokBox server. With this checkbox selected, a Timebox user can click the
Show/edit activities to view a popup window. That window will list all available activity
types. If the checkbox next to an activity type is selected, all activity times of that type will
be sent to the ClokBox server. If the checkbox is not selected, times of that type will not be
sent. This setting will be useful, for example, if a Timebox user is tracking some times that
s/he doesn't want sent or revealed to the ClokBox administrator.

Again, the Specify tasks to send option works in the same way, except it is used to limit the
types of tasks sent.

Finally, ensure the Announce self to server checkbox is selected if you want to announce to
your team when you are online. When this box is selected, TimeBox will tell the ClokBox
server that you are online. As a result, all other TimeBox users who are using the same
ClokBox server as you can know that you are online. In turn, you will be able to see who
else is logged in as well. Once you have a valid ClokBox address/port/username/password
combination entered, and Announce self to server is selected, a small button labeled Users
will appear near the bottom right corner of the main ClokBox window. Activate that button
to see the list of users currently online.

When you are finished entering your settings, click OK at the bottom of the frame.

Once you have entered valid username/password and address/port information in the
submit settings window, you may see up to three new buttons appear in the TimeBox main
screen, near the bottom right-hand corner. The first is a toggle button labeled Users. This
button will appear if you had selected the Announce self to server option. If you enable the
Users button, then a small window will appear to the right. This window will display all
users—including you—who are currently logged into ClokBox. Through this window, you
can also use ClokBox’s QwikMessage feature. Clicking on any users name will pop up a
small window into which you can enter a message. Enter a message to that user and click
“OK”. In a few moments, that user will receive a QwikMessage containing your message.

The second button that might appear would be labeled either Submit or To File. This
button would appear if you selected Manually or Output to File in the SubmitTime  How?
category. If you had selected Manually, this button will be labeled Manually. Clicking it
will cause your times to be submitted to the ClokBox server. If you has selected Output to
File, the button will be labeled  To File. Clicking it will invoke a file dialog, enabling you to
choose a location to save your times to a file. This file should then be sent to your ClokBox
administrator (i.e. via email.)

The third button that will appear from time to time will be labeled Results. The
appearance of this button will indicate that your times have been sent over the Internet to
the ClokBox server, and that the serve has returned the results of the submission. Clicking



this button will open a results window, which will tell you what happened during the
transmission. In this window you will find a table, with a number of columns. Depending
on how often you’ve submitted times to the server, you will also find a number of rows of
data. Each row represents a submission. The last row will always represent your last data
submission to the server.

The rows will indicate the following:
1. Time Sent – The first column displays the date and time during which that data

submission occurred.
2. Status – The second column indicates what errors, if any, occurred (or it will display

“Successful” if no errors occurred.)
3. Days Submitted – The third column lists for which days times were submitted to the

server. If the table cell is too small to display  all of the dates, either double click the
table cell, or highlight it and select the Show Text button at the bottom of the frame.

4. Notes – The last column displays any special notes about the transmission. For
example, if you tried to submit data for activity types that the server did not recognize,
that will reported in this column. If the table cell is too small to display this data, either
double click the table cell, or highlight it and select the Show Text button at the bottom
of the frame.



Automatically retrieving projects and tasks
You can ensure that the names of your projects and tasks are in synch with the names of
the projects and tasks entered in your group's ClokBox application. To do this, first ensure
that the correct ClokBox server information has been entered, as described above. Then
simply use the Remote -> Time Submission -> Find Projects/Tasks... menu item. A small
window will appear, prompting you to either retrieve projects only, tasks only, or projects
and tasks. Ensure that the desired radio button is selected. Then click the Retrieve button.
TimeBox will communicate with ClokBox, and will retrieve all of the projects and/or tasks
contained within the ClokBox instance. Any projects and tasks that are retrieved--that are
also not contained within your TimeBox instance--will be added to your TimeBox instance.

Automatically submitting projects and tasks
You can also submit the names of your projects and tasks to your group's ClokBox
application. This also helps ensure that your project/task names are in synch with the
ClokBox server's names. It also allows you to create new projects or tasks within ClokBox,
rather than relying on a ClokBox administrator to do so (note that the ClokBox
administrator must first grant you permission to do this. In addition, the administrator
may grant you permission simply to suggest new projects/tasks, which would still require
an administrator's approval.)

To do this, first ensure that the correct ClokBox server information has been entered, as
described above. Then simply use the Remote -> Time Submission -> Submit
Projects/Tasks... menu item. A small window will appear, prompting you to select the
names of the projects and/or tasks that you would like to submit to the ClokBox server.
Typically, you would select only the names of the new projects and/or tasks that you'd
created (although the ClokBox server will disregard any duplicates that it receives). Ensure
that the desired names are selected; then click the Submit button. TimeBox will
communicate with ClokBox, and will send all of the projects and/or tasks that you selected
to the ClokBox instance. Provided that you have been granted permissions, the
projects/tasks that you submitted will either be added directly to the ClokBox server, or
will be queued for approval by the ClokBox administrator.



APPENDICES

Appendix A – What is a Port Number?
Most home computer users are accustomed to browsing the Internet with their home
computers. In this sense, the home computer is a client; it contacts a computer called a
server (which contains information that the user wishes to access), requests the
information, and receives it.

Nearly all Internet-capable home computers are also capable of acting as servers as well.
For a computer to act as a server, it must first (of course) be connected to the Internet. It
must also have a constant address that other clients can use to access it. Finally, it must
have special server software running on it. This job of this software is to "listen" for clients
that are contacting the server, and send back the requested information.

Many servers run multiple types of this sort of software at the same time. For example, a
server might be running Web server software in order to serve out Web pages. It might
also be running email server software, FTP server software, telnet server software,
database server software, or software for any other type of server. For this reason, a simple
Internet address is not enough. If I am trying to access the machine called
www.somecompany.com, I need to further specify whether I am trying to access the
machine's Web server, its FTP server, etc.

That's where the concepts of ports come in. Ports can be thought of as internal addresses
that route requests from clients to the appropriate software. They are not physical
connections, but rather numbers that correspond to server software running on the
machine. For example, most Web servers run on port # 80. Web browsers such as
Netscape Navigator know this, and therefore when you request a URL through Netscape,
behind the scenes it adds the port number 80 to the request. Have you ever had to request
a URL that looks like this: http://www.somename.com:8080? If so, you were
requesting a Web server running on www.somename.com under port # 8080.

The TimeBox software contains a mini-Web server designed exclusively for allowing
remote access to the TimeBox instance running on your personal computer. When
installed, the software's server defaults to a fairly uncommon port number, which is
unlikely to interfere with any server software that might happen to be running on your
computer. There is always a chance, however, of such interference, so the software allows
you to change the port number that the software uses. The rest of this help file tells you
how to use the port number to access the software remotely, but the basic idea is to use a
Web browser and type in http://your-computer's-web-address:port-number.


